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TRI-TECHNICAL SYSTEMS, INC. RETURN POLICY 
 
NO RETURNS OR REFUNDS ON SOFTWARE PURCHASES 
 
Due to current technology capabilities, all dealers and prospective customers are encouraged to request a one (1) 
week demo code to preview the polling software, thus allowing users to make an informed decision before 
purchasing. After an order has been processed, customers (end-users) should contact their dealer/reseller if a 
return or refund is requested. All such request must go through the distributing agent. A cancellation code may be 
required by the dealer. Please give that information to the dealer prior to removing the software from the PC. 
 
On products produced from vendors other than TRI-TECHNICAL SYSTEMS, INC., the manufacturer’s warranties 
apply. TRI-TECHNICAL SYSTEMS, INC. does not give or imply that it gives any warranty on any product(s) it 
distributes, including modems and cables. TRI-TECHNICAL SYSTEMS, INC. will provide assistance, on a best-
effort basis only, to customers needing warranty assistance in dealings with the manufacturer(s) of the product(s) 
TRI-TECHNICAL SYSTEMS, INC. distributes. 
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Term 
 
This license is effective until terminated. You may terminate it at any time by destroying the program together with 
all copies, modifications, and merged portions in any form. It will also terminate upon conditions set forth elsewhere 
in this Agreement or if you fail to comply with any term or condition of this Agreement. You agree upon such 
termination to destroy the program together with all copies, modifications, and merged portions in any form 

Limitation of Liability  
 
A) EXCEPT AS OTHERWISE EXPRESSLY PROVIDED HEREIN, TRI-TECHNICAL SYSTEMS, INC. MAKES 

NO WARRANTIES, EITHER EXPRESSED OR IMPLIED, AS TO ANY MATTER WHATSOEVER, 
INCLUDING BUT NOT LIMITED TO: IMPLIED WARRANTIES, MERCHANTABILITY, OR FITNESS FOR A 
PARTICULAR PURPOSE. 

 
B) Except as otherwise provided herein, TRI-TECHNICAL SYSTEMS, INC. shall not be liable for any claims, 

damages, or expenses of any kind, whether made or suffered by the Buyer or any other person, unless such 
claims, damages, or expenses are directly caused by TRI-TECHNICAL SYSTEMS, INC. negligence or willful 
misconduct. 

 
C) The parties agree that in the event any liability is imposed on TRI-TECHNICAL SYSTEMS, INC. arising out of 

or in connection with the purchase or sales of TRI-TECHNICAL SYSTEMS, INC.’s products, it shall be 
impractical or extremely difficult to fix actual damages and, therefore, agrees that the aggregate amounts 
payable by TRI-TECHNICAL SYSTEMS, INC. by reason thereof shall not exceed the amount paid to TRI-
TECHNICAL SYSTEMS, INC. by the Buyer for the product with respect to which such liability is imposed. 
TRI-TECHNICAL SYSTEMS, INC. shall not be liable for delays. 

 
D) TRI-TECHNICAL SYSTEMS, INC. shall in no event be liable to the Buyer or any other party for lost profits, 

diminution of good will, any other incidental, or consequential damages or loss of use, or other commercial 
loss, however occasioned. 
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Software License 
 
TRI-TECHNICAL SYSTEMS, INC. provides this program and licenses its use. You may: 
 
A) Use the program on a single PC. 
 
B) Copy the program into any machine readable or printed form for backup or modification purposes in support 

of your use of the program on a single PC. (Certain programs, however, may include mechanisms to limit or 
inhibit copying. They are marked “copy protected”.) 

 
YOU MAY NOT USE, MODIFY, OR TRANSFER THE PROGRAM OR ANY COPY, MODIFICATION, OR MERGED 
PORTION, IN WHOLE OR IN PART, EXCEPT AS EXPRESSLY PROVIDED FOR IN THIS LICENSE. 
 
IF YOU TRANSFER POSSESSION OF ANY COPY, MODIFICATION, OR MERGED PORTION OF THE 
PROGRAM TO ANOTHER PARTY, YOUR LICENSE IS AUTOMATICALLY TERMINATED. 

Software Warranty 
 
TRI-TECHNICAL SYSTEMS, INC. warrants any article or component supplied but not developed and produced by 
TRI-TECHNICAL SYSTEMS, INC. to the extent warranted to TRI-TECHNICAL SYSTEMS, INC. by the 
manufacturer of such article or component and only to such extent. TRI-TECHNICAL SYSTEMS, INC. warrants 
that, for a period of thirty (30) days from the date of delivery thereof, any software developed and produced by TRI-
TECHNICAL SYSTEMS, INC. shall be free from defects in materials and workmanship, provided, however that 
TRI-TECHNICAL SYSTEMS, INC.’s obligation shall be limited to repair or replacement of any such software which 
is returned to TRI-TECHNICAL SYSTEMS, INC. and shown to TRI-TECHNICAL SYSTEMS, INC.’s satisfaction to 
be defective. TRI-TECHNICAL SYSTEMS, INC.’s repair or replacement of defective software shall be performed 
during TRI-TECHNICAL SYSTEMS, INC.’s normal working hours. This warranty does not apply to any software 
that has been subject to misuse (including failure to follow corrective routines or instructions), negligence, or 
accident by other causes not arising from the fault or negligence of TRI-TECHNICAL SYSTEMS, INC. 
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Receiving Technical Support 
 
First, check the manual that came with your software. When using Windows versions of TRI-TECHNICAL 
SYSTEMS, INC., click the Help button that appears on the main menu. 
 
Call the cash register dealer who sold the cash register and TRI-TECHNICAL SYSTEMS, INC. software for 
answers. 
 
If your dealer cannot help you, support is available in the other forms listed below: 

 Please visit our website:  www.technology4retailers.com. The site contains setup documentation as well as 
instructional tutorials on some of the products. 

 Send email to TRI-TECHNICAL SYSTEMS, INC. at sales@technology4retailers.com. Briefly describe your 
problem. Include your name, company information, telephone number, email address, etc. We will either try 
to put you in contact with a dealer in your area or we do have end-user support options that could be 
contracted directly through TRI-TECHNICAL SYSTEMS, INC. 

 Call 563-556-3556 and ask to speak with a sales representative. We will either try to put you in contact with 
a dealer in your area or we do have end-user support options that could be contracted directly through TRI-
TECHNICAL SYSTEMS, INC. 

Crucial Information 
 

The following information is very important during the analysis of any problem: 
 
1. The version and serial numbers of our software are located on the computer screen when the program is 

running or within the Activation l Release Code section of the software. 
2. The EPROM version of the register and the date it was issued, plus the make and model of the cash register. 
3. Include the exact wording of the error message. 
4. What program you are using: Polling, Inventory, QuickBooks Interface, or DenView. Also, know what were you 

doing at the time the problem occurred and record this information. 
5. Include computer type, system version, and amount of available memory. Also, have the Network configuration 

if applicable. 
6. Include the printer manufacturer, type, and model. 
7. Modem manufacturer, type, and model. 
 
It is often helpful to record answers to your support questions in the software manual in case the same problem is 
encountered in the future. 
 
SPECIAL NOTE:  DEALER SUPPORT AND TRAINING SESSIONS ARE OFFERED OVER THE PHONE. 
DEALERS AND/OR DEALERS AND USERS CAN ALSO COME TO TRI-TECHNICAL SYSTEMS, INC. IN 
DUBUQUE, IA FOR PERSONAL TRAINING ON ALL OF TRI-TECHNICAL SYSTEMS, INC.’S PRODUCTS. 
PLEASE CALL FOR PRICING AS FEES MAY APPLY. 
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Recommended System Additions 
 

System Requirements 
 

 A PC capable of running a Window's Operating System (Note:  It is recommended that users run 
Windows 2000 or above. Some of the software applications will not run on Win98 due to limitations on 
that operating system.) 

 Windows Printer Installed 

 Minimum 256 colors 

 Minimum 800 x 600 resolution (Note: Some Version 7 screens require 1024 x 768.) 

 512 MB of RAM  

 1 GHz processor speed 

 Serial port or modem (if interfacing to V6 Polling) USB to serial and ether to serial devices may be 
used. Some registers also support native TCP/IP communications. Please consult your cash register 
dealer for polling options. 

 

System Recommendations 

 
It is recommended to use WinXP+ for the operating system. Users of Vista or Windows7 may need to install the 
software with compatibility mode or administrative rights. Users of 64 bit operating systems will need complete 
additional setup steps to run a 32 bit application on a 64 bit OS. 64-bit users may also need to verify that their 
hardware devices have drivers for a 64 bit OS. Please contact the vendor of the device for 64-bit drivers.  
 

 Pentium 4 - 1 GHz or equivalent processor 

 20 GB hard drive 

 1 GB+ of RAM 

 1024 x 768 Resolution 

 16 million colors video display 

 Backup medium (ex: zip drive, CD-ROM drive, 3.5 inch floppy drive) 

 An Internet connection, static IP address, and a router may be required for WAN (wide area network) 
polling communications 

 
Backup System 
 
For safety’s sake, a system must be used to backup critical business data. V7 Archive Agent can be used to create 
compressed data backup files. It is highly recommended that users either manually or through the software, 
transfer these archives to an external location such as a network drive, zip drive, or another computer location. 
Backups must be done on a regular basis to be effective. Multiple copies of the backup should be made and kept in 
separate locations in case of fire. For more information, contact your network administrator. 
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Introduction 
 

Overview 
 
DenView500 is a simple, easy-to-use program that allows storeowners to manage their businesses at a fraction of 
the cost of a high-end inventory module. DenView500 helps bridge the gap between Polling and a full-blown 
inventory system. DenView500 allows users to take previously collected Version 6 and Version 7 PLU reports and 
calculate the usage on assembled items.   
 
This software will allow the user to create a Master Items list of all their PLU items and link up to 5 component items 
to each of these Master items. The component items are then attached to Raw Purchasing Units. The reports 
generated reflect the total usage of the Raw Purchasing Units.   
 
DenView500 can be applied to many different types of stores including restaurants and bars.    
 
For example, an item on a PLU report may be 75 Ultimate Burgers. With DenView500 a user can link this PLU item 
to the following components: 1 lb burger patty, 1 bun, and 2 slices of cheese. Then these component items could 
be linked to the Raw Purchasing Units of: a 50 lb package of hamburger, a case of buns and a carton of cheese. 
The report created by DenView500 would show that the store used 1.5 - 50 lb packages of hamburger, 3/4 of a 
case of buns and 1 carton of cheese.   
 
First time users, please read the System Requirements. 
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Getting Started 
 

Installation Instructions 
 
If the DenView500.exe file has been downloaded from the Internet, please search for the file name to locate it on 
your hard drive. If the install is from a CD, just click on the DenView500 Install link.  
 
Note:  The install and entry of the release code must be done with Administrative Rights. Please contact your 
network administrator for help.  
 
 

 
 
 
The first screen that appears during the installation is the Welcome screen. It will display the following message: 
"This Program will install DenView500 on your computer." This screen also recommends that all other running 
applications be closed before continuing with the Setup. Click Next. 
 
 

 
 
 
On the Registration Information screen, please fill out your company information. The software will record this 
information and create a file that can be emailed or faxed to PC/POLL to obtain a release code. The install will not 
continue until all entry areas are filled out. Click Next. 
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If you agree to the conditions listed on the License Agreement screen, click Accept. 
 
 

 
 
 
The screen above is the Readme Information. Please read over the text carefully before clicking Next. 
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Then, select a destination for the software. It is recommended that the default location not be altered unless 
absolutely necessary. Click Next to begin installing the software. 
 
 

 
 
 
After the Setup is finished, your registration information will be displayed. Please print off the information and fax it 
to 563-556-0405 or email it to Tri-Technical Systems at sales@technology4retailers.com . Click Finish on the final 
screen to complete the install.   
 
 

 
 
 
A DenView500 icon will be placed on your desktop. Now the program can be opened by double-clicking on the new 
icon. 
 
 

 
 
 
You will be prompted that the code on file is not valid. Clicking OK will display the Release Code entry screen on 
the next page. 
 
  



13 
 

Release Code Screen 
 
 

 
 
 
Please email your Machine Identification number to Tri-Technical Systems at sales@technology4retailers.com   
for the most efficient way of obtaining the Release Code. If email is not available, call 563-556-3556.  
 
Someone from Tri-Technical Systems will then generate a Release Code and email that code back to you. Enter 
the code and then hit the Update Release Code button. After the code has been entered and accepted by the 
program, hit the Close button to enter the software.   
 
The Machine Identification is an automatically generated number that is unique to your PC. The Tri-Technical 
Systems' staff must have that number in order to generate a release code. 
 
The Release Code determines the Serial Number and Date Range within which the software can be used. The 
Release Code automatically updates this information; it cannot be edited.  
 
Note:  The Computer's Date must be accurate in order for the release code to be accepted by the software. 
 
End-Users should always contact their dealers first with DenView500 questions. If the dealer is unable to answer 
the question, support options are available 
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Quick Setup 
 
 
DenView500 is a quick and easy program to use and a simple program to setup. Below is an outline of the steps 
needed to setup the software. For more information read the Terminology section of this manual. 
 

1. Open DenView500 by clicking on the icon. 
 

2. If this is the first time using the program, go to the File menu and select New. Use the Please Select 
Master File to create a window to select a location and name for the new file. Click Open. See the File 
Menu  topic. 

 
3. If the program has been used before, the software will open the most recently used Master file. If another 

file is desired, use the File menu and select Open. Then search for the desired Master file. Click Open to 
load the selected Master file.  

 
Note:  Users may also create a new Master file. See Step 2. 

 
4. Export all PLU/UPC items from Version 6 or Version 7 Polling. See the Adding Version 6 Items topic or the 

Adding Version 7 Items topic. 
 

5. Import those items into DenView500 using the File menu. See the File Menu  topic. 
 

6. Activate or De-Activate desired Master Items. The Active status can be set manually or through the Options 
menu. See the topic Master Options Menu. 

 
7. Click on the Linked Items tab and add all needed Raw Purchasing Units and Linked Items to the system. 

Each item should be added using the toolbar. For more information on toolbars or Linked Items please read 
the Toolbars topic and the topic on Linked Items Tab. 

 
8. Return to the Master Items tab and link all active PLU/UPC items to their associated Linked Items. See the 

topic on Master Items.  
 
For information on maintaining the system, see the topic of Quick Maintenance. 
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Quick Maintenance 
 
There are really only two operations for the maintenance of DenView500: Importing new data and Resetting totals.   
 
To Import Sales Data into the system: 
 

1. Export individual or consolidated report data from either Version 6 or Version 7 Polling. See the Version 6 
Reports topic or see the Version 7 Reports topic.  

 
2. Import that data into DenView500 via the Sales Data menu. Users can import one report at a time or 

multiple reports all contained within 1 file. See the topic Sales Data Menu. 
 

3. View the Item Usage Report via the Sales Data menu. See the topic Item Usage Report. 
 
To Reset All Sales Data: 
 

1. Go to the Sales Data menu and select the Reset All Sales Data option. Users can reset their sales totals as 
often as needed.  

 
2. DenView500 can store running totals or the system can be cleared after each use. 
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Terminology 
 
File Menu 
 
 

 
 
 
The File Menu allows users to perform basic software operations such as New, Open, Import, Close and Exit. 
 
New:  This option will open and create a new set of Master Item tables. Users are allowed to create multiple tables 
to use with multiple stores or simply use one set of tables for all of their stores. 
 
Open:  This option allows the user to open previously created Master Item tables from anywhere on their computer, 
external drive or network location. 
 
Import:  Through the use of the Import option the user will create their Master Item list. After the item list has been 
exported from PC/POLL Version 6 or Version 7 Polling, the user will open DenView500 and select Import to bring 
their items into the software. For more information on this process, see the Help topic Transferring Data from 
Polling. 
 
Close:  This option will close the currently open Master Item table. 
 
Exit:  The Exit option will close DenView500. 
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Sales Data Menu 
 

 
 
 
From the Sales Data menu, users can import their PLU Sales Data, view a Usage Report of their DenView500 
items, and Reset all of their sales data. 
 
Import Sales Data:  Using this option, users can import previously exported PLU sales report data. The report data 
can be from multiple machines or from a single machine. The data can also be from a consolidated PLU report. 
DenView500 supports all Version 6 and Version 7 cash registers. For more information on this process, see the 
Help Files topic Transferring Data from Polling. 
 
Physical Form:  The physical form is a report users can print off to help count their on-hand items, take a physical 
inventory. 
 
Sales Report:  This option displays a usage report of the user's non-zero DenView500 items. Only items checked 
to Show On Report will be displayed. The Show On Report option is set on the Linked Items tab. See the topic on 
Linked Items Tab. 
 
Reset All Sales Data:  The Reset option will clear out all running totals within DenView500. Master and Linked 
Items will not be removed, just the totals. Resetting allows users to view a smaller data set and thus can be done 
as often as desired by the user. 
 
Reset All Stock Data  DenView500 can be configured to track item usage, on-hand stock values, or both values. 
The reset Stock Data option only resets the current on-hand values to zero. This is similar to the Reset All Sales 
Data option. 
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Setup Menu 
 

 
 
 
The Setup Menu contains an option named Activation. By selecting this option the user's release code information 
will be displayed for viewing or editing. To obtain a new release code users should contact their cash register 
dealer or contact Tri-Technical Systems: 563-556-3556 or sales@technology4retailers.com.  
 
Release Code Screen 
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Master Options Menu 
 

 
 
 
All of these options pertain to the Linked Items tab within the software. DenView500 can be configured to track item 
usage, on-hand stock values, or both values. Item usage is similar to a sales report. Users can see how many 
items were used or sold. Not how many they currently have remaining. The on-hand stock values require users to 
enter a starting inventory value. Then as sales are imported, the numbers sold are deducted from the on-hand 
values to produce a report on the number of items that should be remaining in stock. Users can select a menu 
option to rapidly update all items in their list or select items and manually edit their selections. 
 
 
Activate All Items:  This option will activate, check, Show on Report options for all items for both Stock & Quantity 
sold. 
 
Activate All Sales Items:  This option will activate, check, Show on Report options for all items for only the 
Quantity sold field. The software will be tracking only item usage and not current on-hand stock values. 
 
Activate All Stock Items:  This option will activate, check, Show on Report options for all items for only the Stock 
Quantity field. The software will be tracking remaining in-stock items and not item usage. 
 
Deactivate All Items:  This option will deactivate, uncheck, Show on Report options for all items for both Stock & 
Quantity sold. 
 
Deactivate All Sales Items:  This option will deactivate, uncheck, Show on Report options for all items for only the 
Quantity sold field. The item usage for all items will not appear on the report. 
 
Deactivate All Stock Items:  This option will deactivate, uncheck, Show on Report options for all items for only the 
Stock Quantity field. The stock values for all items will not appear on the report 
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Help Menu 
 

 
 
 
Help:  The Help Option displays the Help File. 
 
 

 
 
 
About:  Displays the current version number of the software and Tri-Technical Systems contact information.  
 
Please use the current contact information: 
Tri-Technical Systems 
3162 Cedar Crest Ridge 
Dubuque, IA  52003 
Voice:  563-556-3556 
Fax:  563-556-0405 
Sales & Support:  sales@technology4retailers.com 
Web:  http://www.technology4retailers.com/  
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Master Items Tab 
 

 
 
 
The Master Items tab:  Displays all imported or created PLU-Master Items and their Linked Items. From this tab, 
users can add new items, change their Linked Items, and set the Active status on each item. 
 
PLUCode:  Displays the PLU or UPC number of the item. These values can be exported from Version 6 or Version 
7 Polling and imported in DenView500. These values can also be manually entered. 
 
Description:  Displays the name of the PLU or UPC item. These values can be exported from Version 6 or Version 
7 Polling and imported in DenView500. These values can also be manually entered. 
 
Active:  The Active status is for both display and sales data importing purposes. If an item is set to inactive and the 
Only Show Active Items option is set, all in-active items will be hidden from view. When sales data is imported, only 
data for active PLUCodes will be brought into the system. Inactive PLUCodes will be skipped. By default, all items 
are Active. 
 
Item 1 - 5:  Within these fields, users can select from a drop-down box containing all created Linked Items. Users 
may connect up to 5 Linked Items to a PLUCode. Note:  DenView500 can also be used as a very simple hard-
goods tracking system. For this type of installation, users would link each PLU item to only one component item. 
For example, if the item were a hammer, the component item would also be a hammer. 
 
Active Preference:  The Only Show Active Items and Show All Items preference allows users to see different 
views of their Master Items list. 
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Linked Items Tab 
 

 
 
 
From the Linked Items tab, the user will add their Raw Purchasing Units and Linked Items to the system. The top 
grid will display all Raw Purchasing Units. The lower grid displays all the Linked Items associated with the selected 
Raw Purchasing Unit. The Quantity Sold columns will display all imported sales totals. The values will be zero when 
setting up the system or after a Reset of All Sales Data. 
 

Top Grid Menu 
 
Raw Purchasing Unit:  This column contains a list of wholesale package units. 
 
Item Units:  Within this column, users should enter the total number of units contained within the Raw Purchasing 
Unit. These units should be calculated by using the smallest sales unit as the divisor. For example, if the Raw Unit 
is 50 lbs. of hamburger and the smallest amount of hamburger that a business uses in any of its dishes is 1/4 lb. 
then the value for Item Units would be 200. The math would be 50 / .25 = 200. Another example is wine. The Item 
Units column contains six, which is the number of glasses per bottle. 
 
Quantity Sold-Whole:  Displays the number of whole Raw Purchasing Units that have been used by the system. 
For example, if the Item Units field is set to 200 and 521 units were used; the Whole field would display 2. These 
fields are populated by the software after an import of PLU report sales data.  
 
Quantity Sold-Partial:  Displays the number of Partial Raw Purchasing Units that have been used by the system. 
For example, if the Item Units field is set to 200 and 521 units were used; the Partial field would display 121. These 
fields are populated by the software after an import of PLU report sales data.  
 
Quantity Sold-Total:  Displays the number of Total Raw Purchasing Units that have been used by the system. The 
value is displayed in decimal form. For example, if the Item Units field is set to 200 and 521 units were used, and 
then the Total field would display 2.605. These fields are populated by the software after an import of PLU report 
sales data.  
 
Show on Report:  This preference allows users to skip or view items on their Item Usage Report.   
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Stock Quantity-Whole:   Displays the number of whole Raw Purchasing Units that remain in stock or on-hand after 
an import of sales data. Prior to importing sales data users should enter starting on-hand values or receive stock. If 
no items are on-hand, the system will display negative values for stock. For example, if the Item Units field is set to 
200 units/box, 521 units were used, and the starting on-hand value was 5 boxes, the Whole field would display 2. 
These fields are populated by the software after an import of PLU report sales data.  
 
Stock Quantity-Partial:  Displays the number of Partial Raw Purchasing Units that remain in stock or on-hand after 
an import of sales data. Prior to importing sales data users should enter starting on-hand values or receive stock. If 
no items are on-hand, the system will display negative values for stock. For example, if the Item Units field is set to 
200 units/box, 521 units were used, and the starting on-hand value was 5 boxes, the Partial field would display 79. 
These fields are populated by the software after an import of PLU report sales data.  
 
Stock Quantity-Total:  Displays the number of Total Raw Purchasing Units that remain in stock or on-hand after 
an import of sales data. Prior to importing sales data users should enter starting on-hand values or receive stock. If 
no items are on-hand, the system will display negative values for stock. The value is displayed in decimal form. For 
example, if the Item Units field is set to 200 units/box, 521 units were used, and the starting on-hand value was 5 
boxes, then the Total field would display 2.395 remaining in stock. These fields are populated by the software after 
an import of PLU report sales data. 
 
Show on Report:  This preference allows users to skip or view stock items on their Item Usage Report.   
 

Lower Grid Menu 
 
Linked Item:  Users should enter in the Linked Item column, all linked items that are associated with the selected 
Raw Purchasing Unit. For example, if the Raw Purchasing Unit was 50 lbs. of hamburger, a few sample Linked 
Items could be 1/4 lb. burger, 1/2 lb. burger, and 1 lb. burger. 
 
Sales Unit(s):  Within this column users should input the number of Item Units used by the Linked Item. For 
example, if the Raw Purchasing Unit is again 50 lbs of hamburger, the number of Item Units is 200 (the number of 
1/4 lb burgers). If the Linked Item were a 1/2 lb burger the number of Sales Units would be 2 because there are two 
1/4 lb burgers in each 1/2 lb burger. 
 
Quantity Sold-Items:  Displays the number of individual, Linked Items sold. For example, if 99 - 1/2 lb burgers 
were sold the Items field would display 99. These fields are populated by the software after an import of PLU report 
sales data.  
 
Quantity Sold-Units:  Displays the number of individual Item Units sold. For example, if 99 - 1/2 lb burgers were 
sold, and each burger uses 2 Item Units, the number of Units sold would be 198. These fields are populated by the 
software after an import of PLU report sales data. 
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Item Usage Report 
 

 
 
 
DenView500 contains an Item Usage Report. This report displays the number of Whole and Partial Raw 
Purchasing Units used along with the associated Linked Item usage. 
 
 
Raw Purchasing Unit:  This is the wholesale packaging unit for an item. 
 
Whole Qty Used:  Displays the number of whole Raw Purchasing Units that have been used by the system. For 
example, if the Item Units field is set to 200 and 521 units were used; the Whole field would display 2. 
 
Partial Qty Used:  Displays the number of Partial Raw Purchasing Units that have been used by the system. For 
example, if the Item Units field is set to 200 and 521 units were used, and then the Partial field would display 121. 
 
Total Qty Used:  Displays the number of Total Raw Purchasing Units that have been used by the system. The 
value is displayed in decimal form. For example, if the Item Units field is set to 200 and 521 units were used, and 
then the Total field would display 2.605. 
 
Linked Item:  This displays a list containing the ways in which the Raw Purchasing Unit is sold. 
 
Quantity Sold-Items:  Displays the number of individual, Linked Items sold. For example, if 99 - 1/2 lb burgers 
were sold the Items field would display 99. 
 
Quantity Sold-Units:  Displays the number of individual Item Units sold. For example, if 99 - 1/2 lb burgers were 
sold, and each burger uses 2 Item Units, the number of Units sold would display 198. 
 
Displayed Items:  In order for items to be displayed on this report, they must contain sales data and the Show On 
Report option, from the Linked Items tab, must be set to active. 
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Stock Whole Qty Used:  Displays the number of whole Raw Purchasing Units that remain in the system after the 
sales numbers have been deducted from on-hand values. For example, if the Item Units field is set to 200 
units/box, 521 units were used, and the starting on-hand value was 5 boxes, the Whole field would display 2. 
 
Stock Partial Qty Used:  Displays the number of Partial Raw Purchasing Units that that remain in the system after 
the sales numbers have been deducted from on-hand values. For example, if the Item Units field is set to 200 
units/box, 521 units were used, and the starting on-hand value was 5 boxes, then the Partial field would display 79. 
 
Stock Total Qty Used:  Displays the number of Total Raw Purchasing Units that remain in the system after the 
sales numbers have been deducted from on-hand values. The value is displayed in decimal form. For example, if 
the Item Units field is set to 200 units/box, 521 units were used, and the starting on-hand value was 5 boxes, then 
the Total field would display 2.395. 
 
Note:  The Active status, on the Master Items tab, can also influence the report data. When sales data is imported, 
into DenView500, only data for active PLUCodes will be brought into the system. De-active PLUCodes will be 
skipped and if there is no data, for a particular Raw Purchasing Unit, it will not be displayed on the report.   
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Item Stock Tab 
 

 
 
 
The Item Stock tab allows users to import or receive stock values for their Raw Purchasing Units. Users can 
choose to append, or add to the existing stock values, or they can completely replace the stock values with a new 
stock value. 
 
 
Append Button:  Users enter in new Whole and Partial stock values into the grid. By pressing the Append button, 
the newly entered values will be added to the existing on-hand values. This is similar to receiving new items. 
 
Replace Button:  Users enter in new Whole and Partial stock values into the grid. By pressing the Replace button, 
the newly entered values completely replace the existing on-hand values. This is similar to taking a physical 
inventory of an item. 
 
Raw Purchasing Unit:  This column contains the list of wholesale package units that were entered on the Linked 
Items tab. 
 
Whole (New/Adjust Stock):  Enter the number of whole Raw Purchasing units that were received or enter a 
physical inventory value for this item. Pressing the Append button will add the entered value to the existing on-hand 
totals. Pressing the Replace button will replace the existing on-hand totals. For example, if the Item Units field is set 
to 200 units/box and 2.5 boxes were received, the whole number would be 2. 
 
Partial (New/Adjust Stock):  Enter the number of partial Raw Purchasing units that were received, or enter a 
physical inventory value. Pressing the Append button will add the entered value to the existing on-hand totals. 
Pressing the Replace button will replace the existing on-hand totals. For example, if the Item Units field is set to 
200 units/box and 2.5 boxes were received, the partial number would be 100 (for half of a 200-unit box). 
 
Stock Whole Quantity:  Displays the current number of whole Raw Purchasing Units that remain in the system 
after the sales numbers have been deducted from on-hand values. For example, if the Item Units field is set to 200 
units/box and 521 units were used and the starting on-hand value was 5 boxes, the Whole field would display 2. 
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Stock Partial Quantity:  Displays the current number of Partial Raw Purchasing Units that remain in the system 
after the sales numbers have been deducted from on-hand values. For example, if the Item Units field is set to 200 
units/box and 521 units were used and the starting on-hand value was 5 boxes, then the Partial field would display 
79. 
 
Stock Total Quantity:  Displays the number of Total Raw Purchasing Units that remain in the system after the 
sales numbers have been deducted from on-hand values. The value is displayed in decimal form. For example, if 
the Item Units field is set to 200 units/box and 521 units were used and the starting on-hand value was 5 boxes, 
then the Total field would display 2.395. 
 
Whole (Last Modified):  Displays the last whole amount that was entered into the system. This number may be 
zero if only partial values were entered for the last append or replace operation. This value can be used as an audit 
trail. 
 
Partial (Last Modified):  Displays the last partial amount that was entered into the system. This number may be 
zero if only whole values were entered for the last append or replace operation. This value can be used as an audit 
trail. 
 
Trans Type – Date – Time:  Displays an “R” or an “A” to indicate if the last update was a Replace or Append. A 
date/time stamp of when the event occurred is also displayed. This value can be used as an audit trail. 
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Sample Screens 
 
Item Usage Report 
 
 

 
 
 
Physical Form 
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Toolbars 
 

 
 
 
On both the Master Items and Linked Items screens are user toolbars. Below are the descriptions of each of the 
toolbar options. 
 
 

 Moves the cursor to the first record in the table. 
 

 Moves the cursor backwards 10 records towards the first record in the table. 
 

 Moves the cursor back to the prior record. 
 

 Moves the cursor forward one record. 
 

 Moves the cursor forward 10 records towards the last record in the table. 
 

 Moves the cursor to the last record in the table. 
 

 Inserts a new record into the table. 
 

 Deletes the selected record from the table. 
 

 Places the currently selected record into an edit state to allow users to make changes. 
 

 Posts changes to a record to the database. 
 

 Cancels the changes made to the currently selected record. This option must be used prior to posting 
the edit. 

 

 Refreshes the data from the database. 
 

 Inserts a bookmark on the currently selected record. A bookmark is a placeholder that can be easily 
returned to by clicking on the GoTo button. 

 

 Returns the cursor to the previously created bookmark. The software can only store one bookmark at a 
time. 
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Software Prompts 
 
DenView500 was designed to display usage and stock data on-demand. The software can store running totals, 
however making major edits to such fields as Item Units and Linked Units, with running totals, is not recommended 
as the changes may skew the data. 
 
 

 
 
 
Before making dramatic edits, it is strongly recommended that users go to the Sales Data menu and scroll down to 
Reset All Sales Data to reset all their sales data. 
 
 

 
 
 
The Warning screen above will open. Click the OK button to proceed or Cancel to stop the reset. 
 
The user should pick Reset All Stock Data from the Sales Data menu. 
 
 

 
 

 
 
The Warning screen above will open. To proceed, click OK or to cancel the reset click on Cancel. 
Within the software, user prompts have been added to help users make minor changes to their setup. Below is a 
listing of the prompts and an explanation of the functions. 
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The messages above will appear if the user attempts to edit either the Item Units or Sales Units fields. Changing 
these fields will result in the software resetting all totals values associated with these items. 
 
 

 
 
 
Changing a descriptor of a linked item will result in the message above. If Yes is selected the software will go 
through the Master Items table and update each record. 
 
 

 
 
 
If a Linked Item with the same descriptor is added to the software, the message above will appear. Linked Item 
descriptors must be unique. 
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The software will display the prompt above when deleting a Master, Raw Purchasing, or Linked Item. Deleting a 
Raw Purchasing or Linked Item will result in the software automatically removing all associated links from the 
Master Items list. 
 
 

 
 
 
If a Raw Purchasing Unit is added or edited to display 0 Item Units, the software will display the above prompt. 0 
Item Units is not allowed by the software. 
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Transferring Data from Polling 
 
Version 6 Items 
 
DenView500 receives both its Master Items and sales data from Version 6 and/or Version 7 Polling. Below are the 
instructions for using Version 6 Polling. 
 

Exporting Master Items 
 
The Master Items list is populated from Version 6 Polling's PLU/UPC list. To export PLU/UPC items from Version 6 
please follow the steps below. 
 
 

 
 
 

1. Open Version 6 Polling and click on the Setup button. 
 
 

 
 
 

2. From within the Setup menu select Preferences button. 
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3. Click on the Options tab. The exact name of the options tab will depend upon which register type is being 
used. For example, a TEC register would have a TEC Options tab. Sharp would have a Sharp Options 
tab (as in the example above),  CRS a CRS Options tab, and Sam4s would have a Sam4s Options tab. 

 
 

 
 
 

4. Within Listing Options, select Item Listing 2. 
 
 

 
 
 

5. Make sure the File has the Column Headers option is unchecked. Click OK at the bottom of the 
Preferences screen. 
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6. Now return to the main screen of the software and select Maintain.   
 

7. Highlight the desired machine and click Select. 
 
 

 
 
 

8. From within the Program Selector open the PLU/UPC file. 
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9. The PLU Grid will open. On the PLU/UPC grid there is a button named Listing Export. Click the button. 
 
 

 
 
 

10. A Save As screen opens. Select a destination for the export information then click the Open button. Note:  
Be sure to remember the name and location of the file. 
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11. Open DenView500 and from the File menu select Import. 
 
 

 
 
 

12. Locate the exported file and import the data into DenView500. 
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Version 6 Reports 
 
A special report export format has been created for use with DenView500. This format can be used via manual or 
auto exports. In order to access this report format users will need to have Version 6 Polling build 88 or greater. All 
users should contact their dealers before updating. 
 
Exporting Version 6 Report Data 
 
 

  
 
 

1. Open Version 6 Polling and click on the Setup button. 
 

2. From within the Setup menu select Preferences. 
 

 
 
 

3. On the General tab, under Report File Export Type, select DenView500, the second to last option. This 
option will apply to both manual exports and auto-exports. 
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4. To export V6 Polling data manually simply return to V6 Polling's main menu and click on the Data button. 
 
 

 
 
 

5. From within the AllPolls grid, select the desired PLU/UPC reports to export. To multi-select reports, use 
the ctrl or shift keys on the keyboard. Note:  Only PLU or UPC reports can be exported to DenView500. 

 
6. Click on the Export button.  

 
 

 
 
 

7. Select a name and location for the file. 
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8. Open DenView500 and from the Sales Data menu select Import Sales Data. 
 
Note:  To export data via the auto export option a script and schedule must be setup. For more information on 
these features, please consult the Version 6 help files. 
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Version 7 Items 
 
 
DenView500 receives both its Master Items and sales data from Version 6 and/or Version 7 Polling. Below are the 
instructions for using Version 7 Polling. 
 

Exporting Master Items 
 
The Master Items list is populated from Version 7 Polling's PLU/UPC list. To export PLU/UPC items from Version 7 
please follow the steps below. 
 
 

 
 
 

1. Open Version 7 Polling and click on the Machine List button. 
 

2. Select a machine from the Machine List by simply clicking on the machine name. 
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3. Click on the Maintain button to display a list of programs associated with the selected machine. 
 

4. Scroll down to and click on PLU/UPC. 
 
 

 
 
 

5. From within the Version 7 toolbar area select the Export text file  button. 
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6. On the Export menu select the following 3 fields to export:  PLU/UPC number, PLU/UPC name and 
PLU/UPC price. Note: The exact names may vary per machine type. 

 
7. Select Comma Delimited and click the Export Table button.  

 
8. A Save As screen will open. Pick a location and a name for the file. Be sure to remember the location of the 

file. Note:  If any of the PLU/UPC item names contain commas, user must check the Put Quotes Around 

Text option before exporting. 
 
 

 
 
 

9. If the export is successful the screen above will open. Click OK. 
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10. Open DenView500 and from the File menu select Import. 
 
 

 
 
 

11. Locate the exported file and import the data into DenView500. 
 
For instructions on exporting report data, see the Version 7 Report topic on the next page. 
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Version 7 Reports 

 
A special report export format has been created for use with DenView500. This format can be used via manual or 
auto exports. In order to access this report format users will need to have Version 7 Polling build 60 or greater. All 
users should contact their dealer before updating.   
 

Exporting Version 7 Report Data 

 
 

 
 
 

1. Open Version 7 Polling and click on the Preferences button from the menu on the left. 
 
 

 
 
 

2. From within the Preferences menu select the Report Options tab. 
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3. Within the Report File Export Format area, select the DenView500 option from the PLU Export Format 
drop down menu. This option will apply to both manual exports and auto-exports. 

 
 

 
 
 

4. To export V7 Polling data manually click on the Reports button from the left menu. 
 
 



47 
 

 
 
 

5. From within the Polled Reports grid select the desired PLU/UPC reports to export by clicking on them to 
highlight them. To multi-select reports, use the Ctrl or Shift keys on the keyboard. 

 
Note:  Only PLU or UPC reports can be exported to DenView500. 
 

6. Click on the Export Text File  button from the toolbar near the top of the screen. Select a name and 
location for the file.   

 
 

 
 
 

7. Open DenView500 and from the Sales Data menu select Import Sales Data. 



48 
 

 
Note: To export data via the auto export option a script and schedule must be setup. For more information on these 
features, please consult the Version 7 Help Files or online tutorials. 
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